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Introduction

The acoustic conditions of a car interior contribute greatly to the overall comfort of the 
vehicle as perceived by the driver and passengers. Simulations can be performed to 
optimize for speaker locations of sound systems with respect to mirror sources (sound 
reflections in the windscreen), damping, for signal processing (DSP) improvement, and 
other factors.

This model analyses the low- to mid-frequency range performance of the sound system in 
a car cabin. The cabin is a typical sedan interior, that is, the inside of a hard-top family car. 
The model studies the frequency response at the location of a microphone array and the 
modal behavior at low frequencies.

The cabin is considered a small volume within the scope of room acoustics due to a large 
part of the frequency range of interest being dominated by modal behavior. It is best 
solved with a wave-based approach, in this case the Finite Element Method (FEM), to 
accurately determine the acoustic properties inside the volume. The size of the model 
allows a relatively short computation time in the frequency domain. Up to 1 kHz the 
model is solved using a direct solver. At higher frequencies it is solved with an iterative 
approach that uses the complex shifted Laplacian method (CSL).

Note: In addition to the Acoustics Module, this model requires the AC/DC Module and 
the CAD Import Module.
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Model Definition

The analysis of the car cabin is performed with the Pressure Acoustics, Frequency Domain 
interface. The model geometry, depicted in Figure 1, has a total interior volume of 
3.35 m3.

Figure 1: Geometry of the car cabin.

The boundary conditions are defined with generic absorption and impedance data. The 
values used are found under Global Definition > Parameters 2 - Boundaries. The windows, 
dashboard, and doors are modeled using constant absorption coefficients inspired by 
measurements found in Ref. 1. This is an approximation as only purely resistive losses are 
modeled; at lower frequencies it can be important to include the reactive part of the 
impedance to get the correct phase. The complex-valued impedance data of the leather 
seats is based on experimental values presented in Ref. 2. It is imported into an 
interpolation function from the file car_cabin_acoustics_impedance_seats.txt. 
The roof trim and the carpet floor are defined using the Porous layer option in the 
Impedance boundary condition. The porous materials are modeled with the semi-empirical 
Delany–Bazley–Miki poroacoustic model, using Qunli’s and Miki’s constants to describe the 
3 |  C A R  C A B I N  A C O U S T I C S  —   F R E Q U E N C Y - D O M A I N  A N A L Y S I S



foam and fiber materials, respectively. The resulting absorption coefficients of selected 
surfaces at 2000 Hz can be seen in Figure 2.

Figure 2: Absorption coefficients of various surfaces at 2000 Hz.

The model is driven by loudspeakers placed in the typical locations of a car interior. A 
lumped Thiele/Small representation (of the electrical and mechanical domains) is 
implemented with the Electrical Circuit interface for a generic midwoofer and a generic 
tweeter. They are coupled to the acoustic domain using the Lumped Speaker Boundary 
condition. Protective grid covers are also modeled in front of the speakers using the 
Interior Perforated Plate condition. Generic values are used for the perforation 
configuration.

The loudspeakers are also described with a full lumped models, comprising the electrical, 
mechanical, and acoustical parts. This analysis gives a fast approximate response of the 
speakers. For the lumped acoustic circuit, including the radiation impedance and 
compliance of the closed back volume, see Ref. 3. The impedance and back volume 
compliance is defined in Definitions > Variables 2 Electrical Circuit, using analytic functions 
for the piston impedance and Struve function. The lumped frequency response of the 
speakers, when placed in an infinite baffle, is shown in Figure 3. Note that the cross over 
only happens at about 1000 Hz.
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The lumped (Thiele/Small) representation is a low-frequency approximation that is 
typically valid as long as the transducers retain their piston behavior. The approximation is 
no longer valid when breakup occurs (mechanical modes in the speaker structures). Using 
the lumped speaker boundary feature will, however, give a good assessment of the overall 
acoustic behavior.

Figure 3: Frequency response of the tweeter and midwoofer loudspeakers. Response curves from 
a full lumped model.

The cabin response is first solved with a 1/12 octave resolution from 50 Hz to 1 kHz 
using a direct solver. To reduce the model size and save disk space the solution is only 
stored on a microphone array. The model is further solved at 2 kHz, 3 kHz, and 4 kHz 
using an iterative solver. At 4 kHz the solution time is in the order of some minutes 
(depending on the hardware) and requires about 45 GB of RAM. Running the model 
(which is a full wave simulation) to a high frequency before switching to, for example, ray 
tracing is readily done.

Results and Discussion

The modal analysis allows to investigate the properties of the acoustic domain 
independently of the excitation. It returns the first eigenfrequencies and their 
corresponding modes. Two modes are shown in Figure 4, at f = 111.24 Hz and 
f = 129.63 Hz. The first of these modes can be identified to be equivalent to the (1,1,0) 
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mode in a rectangular enclosure. The second one appears more complex and stems from 
the irregular geometry and boundary conditions of the car cabin.

Figure 4: Eigenmodes of the car cabin. Left column: sound pressure; right column: SPL; top 
row: f = 111.24 Hz; bottom row: f = 129.63 Hz.

The frequency response of the car cabin is first considered with both the left midwoofer 
and the right tweeter active. The result of averaging the sound pressure in three 
microphone locations corresponding to the driver’s head position is depicted in Figure 5. 
The Octave Band plot comes in handy as it can automatically average over several selected 
points. The response is shown for a 1/12 octave resolution. The large dips and peaks 
observed at low frequencies are due to the resonant behavior of the car interior and are 
seen to coincide with the computed eigenfrequencies. The frequencies solved for in Study 
3 and 4 can also be updated to an even finer resolution if needed.
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Figure 5: Frequency response of the car cabin with a midwoofer and a tweeter active.

The car cabin is studied with two different loudspeaker setups. In one case, both a 
midwoofer and a tweeter are active, while in the other case only the tweeter is active. 
Figure 6 shows the two resulting frequency responses at the same location as previously. 
This type of comparison allows to identify the frequency ranges where the response is 
dominated by one or the other loudspeaker. In this example, it is observed that the 
response from the tweeter becomes important from around 350 Hz and above. It should, 
however, be pointed out that frequency responses depend on the receiver position 
(distance to source), and a different result could be found at another location of the car 
cabin. At even higher frequencies directivity starts to play an important role.
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Figure 6: Comparison between loudspeaker setups at the driver location.

In the last study, where the model is solved at 2 kHz, 3 kHz, and 4 kHz, the solution is 
stored also on the model boundaries. The sound pressure level (SPL) at 4 kHz on all the 
model surfaces is plotted in Figure 7. Naturally, the SPL is found to be the highest on 
surfaces close to the dominating sound sources (here the tweeter), such as the dashboard 
and windshield. The directivity and the reflections in the windshield are also seen. With all 
the speakers located at the front of the car, it also follows that the SPL is higher on the 
front seats than on the back seats. This is especially true at high frequencies as depicted 
here.
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Figure 7: SPL inside the car cabin at 4000 Hz.

Notes About the COMSOL Implementation

Several actions are taken in this model in order to reduce computation time:

• The imported CAD geometry is a complex model with many small edges and surfaces, 
which can lead to an unnecessarily large number of mesh elements. The CAD geometry 
is defeatured using the automatic Remove Details functionality.

• The mesh optimization is set to avoid small elements. Small mesh details are also 
avoided by manually controlling the options of the mesh generation.

• In the low-frequency range (below 1000 Hz) the model is solved using the default 
direct solver. The Block low rank factorization option is turned on as it improves the 
solver performance in this case.

• At high frequencies, the solution is found via an iterative solver with the complex shifted 
Laplacian (CSL) method. The solver is one of the predefined iterative solver 
suggestions. This method ensures convergence at a faster rate and with a significantly 
smaller memory consumption than the default direct solver.

• The variable fields calculated in the frequency studies are only stored for the points in 
the microphone array. In the last study with three single (higher) frequencies, the 
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solution is also stored on the geometry boundaries. This allows to reduce the size of the 
saved file.
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Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Acoustics > Pressure Acoustics > Pressure Acoustics,

Frequency Domain (acpr).

3 Click Add.

4 In the Select Physics tree, select AC/DC > Electrical Circuit (cir).

5 Click Add.

6 Click Add.

7 Click Study.

8 In the Select Study tree, select General Studies > Frequency Domain.

9 Click Done.
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G E O M E T R Y  1

Start by importing the geometry from an MPHBIN-file. Then, create faces for the 
loudspeaker covers and points to represent a microphone array at the front of the car cabin.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Advanced section.

3 From the Geometry representation list, choose CAD kernel.

4 From the Default repair tolerance list, choose Relative.

Import 1 (imp1)
1 In the Geometry toolbar, click Import.

2 In the Settings window for Import, locate the Source section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
car_cabin_acoustics_geometry.mphbin.

Cap Faces 1 (cap1)
1 In the Geometry toolbar, click Defeaturing and Repair and choose Cap Faces.

2 Click the Wireframe Rendering button in the Graphics toolbar.

3 On the object imp1, select Edges 53, 54, 56, 57, 389, 390, 392, and 393 only.

Point 1 (pt1)
1 In the Geometry toolbar, click More Primitives and choose Point.

2 In the Settings window for Point, locate the Point section.

3 In the x text field, type 2.

4 In the y text field, type -0.55.

5 In the z text field, type 1.2.

Array 1 (arr1)
1 In the Geometry toolbar, click Transforms and choose Array.

2 Select the object pt1 only.

3 In the Settings window for Array, locate the Size section.

4 In the x size text field, type 6.

5 In the y size text field, type 12.

6 Locate the Displacement section. In the x text field, type 0.1.

7 In the y text field, type 0.1.
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8 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

9 Find the Cumulative selection subsection. Click New.

10 In the New Cumulative Selection dialog, type Microphone Array in the Name text field.

11 Click OK.

Microphone Array (Domain)
1 In the Model Builder window, expand the Component 1 (comp1) > Geometry 1 > 

Cumulative Selections node, then click Microphone Array (Domain).

2 In the Settings window for Selection, locate the Resulting Selection section.

3 Clear the Show in physics checkbox.

Microphone Array (Boundary)
1 In the Model Builder window, click Microphone Array (Boundary).

2 In the Settings window for Selection, locate the Resulting Selection section.

3 Clear the Show in physics checkbox.

Microphone Array (Edge)
1 In the Model Builder window, click Microphone Array (Edge).

2 In the Settings window for Selection, locate the Resulting Selection section.

3 Clear the Show in physics checkbox.

Proceed with creating explicit selections to group the different types of boundary surfaces 
together.

Windows
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Windows in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object ige1, select Boundaries 3, 4, 62, 63, 507, 515, 807, 814, 838, 841, 844, 
and 845 only.

Dashboard
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Dashboard in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.
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4 Click the Paste Selection button for Entities to select.

5 In the Paste Selection dialog, type ige1: 1, 2, 5-9, 11-30, 42-44, 47-52, 54-
57, 64-71, 85-92, 95-97, 99-109, 115-119, 121-127, 130-145, 147-150, 

152, 153, 162-166, 328-330, 335-339, 341, 792, 839 in the Selection text field.

6 Click OK.

Carpet floor
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Carpet floor in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object ige1, select Boundary 10 only.

Doors
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Doors in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 Click the Paste Selection button for Entities to select.

5 In the Paste Selection dialog, type ige1: 155, 157-161, 167, 168, 175, 176, 
181-203, 212-215, 218-236, 259, 261-267, 273, 281, 282, 284, 285, 296-

310, 314, 322-327, 367-370, 373-386, 389-400, 413, 414, 435, 436, 445, 

446, 458, 509, 519-587, 593, 594, 607-620, 639-644, 647-661, 663-672, 

680-691, 695, 697-706 in the Selection text field.

6 Click OK.

Leather seats
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Leather seats in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 Click the Paste Selection button for Entities to select.

5 In the Paste Selection dialog, type ige1: 204, 205, 208, 209, 216, 217, 237, 
238, 240-242, 245, 246, 249, 250, 253-256, 282, 288-295, 310, 311, 314-

317, 343-352, 357-366, 371, 372, 387, 388, 395, 401-412, 417-434, 437-

444, 447-453, 467-473, 483-494, 588, 589, 591, 592, 595-606, 621, 622, 
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628-638, 673-679, 686, 695, 696, 707, 708, 723, 734-747, 752-774, 783-

790, 793-802, 816-835 in the Selection text field.

6 Click OK.

Roof trim
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Roof trim in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 Click the Paste Selection button for Entities to select.

5 In the Paste Selection dialog, type ige1: 270, 271, 495, 496, 748, 749 in the 
Selection text field.

6 Click OK.

Speaker Covers
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Speaker Covers in the Label text 
field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object ige1, select Boundaries 33, 36, 171, and 174 only.

Midwoofer L
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Midwoofer L in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object ige1, select Boundaries 169, 170, 177, and 178 only.

Midwoofer R
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Midwoofer R in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object ige1, select Boundaries 172, 173, 179, and 180 only.
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Tweeter R
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Tweeter R in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object ige1, select Boundaries 39 and 40 only.

Tweeter L
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Tweeter L in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object ige1, select Boundaries 37 and 38 only.

Remove Details 1 (rmd1)
In the Geometry toolbar, click Virtual Operations and choose Remove Details.

Ignore Edges 2 (ige2)
1 In the Geometry toolbar, click Virtual Operations and choose Ignore Edges.

2 In the Settings window for Ignore Edges, locate the Input section.

3 Click the Paste Selection button for Edges to ignore.

4 In the Paste Selection dialog, type 1178, 1183, 1191, 1678, 1686 in the Selection 
text field.

5 Click OK.

6 In the Geometry toolbar, click Build All.

D E F I N I T I O N S

Change the view settings to improve the rendering of 3D plots.

View 1
1 In the Model Builder window, expand the Component 1 (comp1) > Definitions node, then 

click View 1.

2 In the Settings window for View, click to expand the Visual Effects section.

3 Select the Ambient occlusion checkbox.

Import the model parameters from text files. These include the ambient conditions and 
boundary conditions for acoustics, as well as parameter values for the loudspeaker electrical 
circuits.
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G L O B A L  D E F I N I T I O N S

Parameters 1 - Model
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1 - Model in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
car_cabin_acoustics_parameters_model.txt.

Parameters 2 - Boundaries
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 2 - Boundaries in the Label 
text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
car_cabin_acoustics_parameters_boundaries.txt.

Parameters 3 - Midwoofer
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 3 - Midwoofer in the Label 
text field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
car_cabin_acoustics_parameters_midwoofer.txt.

Parameters 4 - Tweeter
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 4 - Tweeter in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
car_cabin_acoustics_parameters_tweeter.txt.

Interpolation 1 - Leather Seats
1 In the Home toolbar, click Functions and choose Global > Interpolation.

2 In the Settings window for Interpolation, type Interpolation 1 - Leather Seats in 
the Label text field.
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3 Locate the Definition section. From the Data source list, choose File.

4 Click Browse.

5 Browse to the model’s Application Libraries folder and double-click the file 
car_cabin_acoustics_impedance_seats.txt.

6 Locate the Data Column Settings section. In the table, click to select the cell at row 
number 1 and column number 1.

7 In the Unit text field, type Hz.

8 In the table, enter the following settings:

9 In the table, click to select the cell at row number 2 and column number 1.

10 In the Name text field, type realZ_seat.

11 In the Unit text field, type 1.

12 In the table, click to select the cell at row number 3 and column number 1.

13 In the Name text field, type imagZ_seat.

14 In the Unit text field, type 1.

15 Locate the Interpolation and Extrapolation section. From the Interpolation list, choose 
Piecewise cubic.

16 Locate the Definition section. Click Import.

Analytic 1 - Struve Function (Order One)
1 In the Home toolbar, click Functions and choose Global > Analytic.

2 In the Settings window for Analytic, type Analytic 1 - Struve Function (Order 
One) in the Label text field.

3 In the Function name text field, type h1.

4 Locate the Definition section. In the Expression text field, type 2/pi-besselj(0,x)+
(16/pi-5)*sin(x)/x+(12-36/pi)*(1-cos(x))/x^2.

5 Locate the Units section. In the Function text field, type 1.

6 In the table, enter the following settings:

Columns Type Settings

Column 2 Function values Function name=int1a

Argument Unit

x 1
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7 Click to expand the Advanced section. Select the 
May produce complex output for real arguments checkbox.

8 Locate the Plot Parameters section. In the table, enter the following settings:

Analytic 2 - Piston Impedance
1 In the Home toolbar, click Functions and choose Global > Analytic.

2 In the Settings window for Analytic, type Analytic 2 - Piston Impedance in the 
Label text field.

3 In the Function name text field, type Zp.

4 Locate the Definition section. In the Expression text field, type rho0*c0*(1-
besselj(1,2*x)/x+i*h1(2*x)/x).

5 Locate the Units section. In the Function text field, type kg/(s*m^2).

6 In the table, enter the following settings:

7 Locate the Advanced section. Select the May produce complex output for real arguments 
checkbox.

8 Locate the Plot Parameters section. In the table, enter the following settings:

A D D  M A T E R I A L

1 In the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-in > Air.

4 Click the Add to Component button in the window toolbar.

5 In the Home toolbar, click Add Material to close the Add Material window.

Plot Argument Lower limit Upper limit Fixed value Unit

√ x 0 10 0 1

Argument Unit

x 1

Plot Argument Lower limit Upper limit Fixed value Unit

√ x 0 10 0 1
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D E F I N I T I O N S

Variables 1 - Acoustics
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

2 In the Settings window for Variables, type Variables 1 - Acoustics in the Label text 
field.

3 Locate the Variables section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
car_cabin_acoustics_variables_acoustics.txt.

Variables 2 - Electrical Circuits
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables 2 - Electrical Circuits in 
the Label text field.

3 Locate the Variables section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
car_cabin_acoustics_variables_electrical_circuits.txt.

All Boundaries
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type All Boundaries in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select the All boundaries checkbox.

Sound Hard Surfaces
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Sound Hard Surfaces in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, select All Boundaries in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.
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9 In the Add dialog, in the Selections to subtract list, choose Windows, Dashboard, 
Carpet floor, Doors, Leather seats, Roof trim, Speaker Covers, Midwoofer L, Midwoofer R, 
Tweeter R, and Tweeter L.

10 Click OK.

All Speakers
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type All Speakers in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Midwoofer L, Midwoofer R, 
Tweeter R, and Tweeter L.

6 Click OK.

Now set up the physics of the model. Boundary conditions are defined with the Impedance 
feature. A generic midwoofer and a generic tweeter are modeled as electrical circuits that 
are coupled to the acoustic domain with the Lumped Speaker Boundary feature.

P R E S S U R E  A C O U S T I C S ,  F R E Q U E N C Y  D O M A I N  ( A C P R )

Pressure Acoustics 1
1 In the Model Builder window, under Component 1 (comp1) > Pressure Acoustics,

Frequency Domain (acpr) click Pressure Acoustics 1.

2 In the Settings window for Pressure Acoustics, locate the Pressure Acoustics Model 
section.

3 From the Fluid model list, choose Atmosphere attenuation.

4 Locate the Model Input section. In the φw text field, type relH.

Impedance 1 - Windows
1 In the Physics toolbar, click Boundaries and choose Impedance.

2 In the Settings window for Impedance, type Impedance 1 - Windows in the Label text 
field.

3 Locate the Boundary Selection section. From the Selection list, choose Windows.

4 Locate the Impedance section. From the Impedance model list, choose 
Absorption coefficient.

5 In the αn text field, type alpha_win.
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Impedance 2 - Dashboard
1 In the Physics toolbar, click Boundaries and choose Impedance.

2 In the Settings window for Impedance, type Impedance 2 - Dashboard in the Label 
text field.

3 Locate the Boundary Selection section. From the Selection list, choose Dashboard.

4 Locate the Impedance section. From the Impedance model list, choose 
Absorption coefficient.

5 In the αn text field, type alpha_dash.

Impedance 3 - Carpet Floor
1 In the Physics toolbar, click Boundaries and choose Impedance.

2 In the Settings window for Impedance, type Impedance 3 - Carpet Floor in the Label 
text field.

3 Locate the Boundary Selection section. From the Selection list, choose Carpet floor.

4 Locate the Impedance section. From the Impedance model list, choose Porous layer.

5 In the d text field, type d_carp.

6 From the Direction of incident wave list, choose Automatic.

7 Locate the Fluid Properties section. From the Fluid material list, choose Air (mat1).

8 Locate the Porous Matrix Properties section. From the Porous elastic material list, choose 
Air (mat1).

9 From the Rf list, choose User defined. In the associated text field, type Rf_carp.

10 From the Constants list, choose Miki.

Impedance 4 - Doors
1 In the Physics toolbar, click Boundaries and choose Impedance.

2 In the Settings window for Impedance, type Impedance 4 - Doors in the Label text 
field.

3 Locate the Boundary Selection section. From the Selection list, choose Doors.

4 Locate the Impedance section. From the Impedance model list, choose 
Absorption coefficient.

5 In the αn text field, type alpha_door.

Impedance 5 - Leather Seats
1 In the Physics toolbar, click Boundaries and choose Impedance.

2 In the Settings window for Impedance, type Impedance 5 - Leather Seats in the 
Label text field.
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3 Locate the Boundary Selection section. From the Selection list, choose Leather seats.

4 Locate the Impedance section. In the Zn text field, type Zn_seat.

Impedance 6 - Roof Trim
1 In the Physics toolbar, click Boundaries and choose Impedance.

2 In the Settings window for Impedance, type Impedance 6 - Roof Trim in the Label 
text field.

3 Locate the Boundary Selection section. From the Selection list, choose Roof trim.

4 Locate the Impedance section. From the Impedance model list, choose Porous layer.

5 In the d text field, type d_roof.

6 From the Direction of incident wave list, choose Automatic.

7 Locate the Fluid Properties section. From the Fluid material list, choose Air (mat1).

8 Locate the Porous Matrix Properties section. From the Porous elastic material list, choose 
Air (mat1).

9 From the Rf list, choose User defined. In the associated text field, type Rf_roof.

10 From the Constants list, choose Qunli.

Constants are taken from Qunli’s model to represent thin foam layers.

Interior Perforated Plate 1
1 In the Physics toolbar, click Boundaries and choose Interior Perforated Plate.

2 In the Settings window for Interior Perforated Plate, locate the Boundary Selection 
section.

3 From the Selection list, choose Speaker Covers.

4 Locate the Interior Perforated Plate section. In the σ text field, type 0.5.

5 Locate the Fluid Properties section. From the Fluid material list, choose Air (mat1).

Lumped Speaker Boundary 1 - Midwoofer L
1 In the Physics toolbar, click Boundaries and choose Lumped Speaker Boundary.

2 In the Settings window for Lumped Speaker Boundary, type Lumped Speaker Boundary 
1 - Midwoofer L in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Midwoofer L.

4 Locate the Back Volume Correction section. In the Vback text field, type Vback_m.

Lumped Speaker Boundary 2 - Tweeter R
1 In the Physics toolbar, click Boundaries and choose Lumped Speaker Boundary.
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2 In the Settings window for Lumped Speaker Boundary, type Lumped Speaker Boundary 
2 - Tweeter R in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Tweeter R.

4 Locate the Back Volume Correction section. In the Vback text field, type Vback_t.

E L E C T R I C A L  C I R C U I T  -  M I D W O O F E R

1 In the Model Builder window, under Component 1 (comp1) click Electrical Circuit (cir).

2 In the Settings window for Electrical Circuit, type Electrical Circuit - Midwoofer 
in the Label text field.

Voltage Source 1 (V1)
In the Electrical Circuit toolbar, click Voltage Source.

Resistor 1 (R1)
In the Electrical Circuit toolbar, click Resistor.

Inductor 1 (L1)
In the Electrical Circuit toolbar, click Inductor.

Current-Controlled Voltage Source 1 (H1)
In the Electrical Circuit toolbar, click Current-Controlled Voltage Source.

Current-Controlled Voltage Source 2 (H2)
In the Electrical Circuit toolbar, click Current-Controlled Voltage Source.

Inductor 2 (L2)
In the Electrical Circuit toolbar, click Inductor.

Resistor 2 (R2)
In the Electrical Circuit toolbar, click Resistor.

Capacitor 1 (C1)
In the Electrical Circuit toolbar, click Capacitor.

External I vs. U 1 (IvsU1)
In the Electrical Circuit toolbar, click External I vs. U.

Voltage-Controlled Voltage Source 1 (E1)
In the Electrical Circuit toolbar, click Voltage-Controlled Voltage Source.

Current-Controlled Current Source 1 (F1)
In the Electrical Circuit toolbar, click Current-Controlled Current Source.
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Resistor 3 (R3)
In the Electrical Circuit toolbar, click Resistor.

Resistor 4 (R4)
In the Electrical Circuit toolbar, click Resistor.

Voltage Source 1 (V1)
1 In the Model Builder window, click Voltage Source 1 (V1).

2 In the Settings window for Voltage Source, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the vsrc text field, type V0.

Resistor 1 (R1)
1 In the Model Builder window, click Resistor 1 (R1).

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type R1_m.

Inductor 1 (L1)
1 In the Model Builder window, click Inductor 1 (L1).

2 In the Settings window for Inductor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the L text field, type L1_m.

Current-Controlled Voltage Source 1 (H1)
1 In the Model Builder window, click Current-Controlled Voltage Source 1 (H1).

Label Node names
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2 In the Settings window for Current-Controlled Voltage Source, locate the 
Node Connections section.

3 In the table, enter the following settings:

4 Locate the Current Measurement section. From the Measure current for device list, 
choose Inductor 2 (L2).

5 In the Gain text field, type A_m.

Current-Controlled Voltage Source 2 (H2)
1 In the Model Builder window, click Current-Controlled Voltage Source 2 (H2).

2 In the Settings window for Current-Controlled Voltage Source, locate the 
Node Connections section.

3 In the table, enter the following settings:

4 Locate the Current Measurement section. From the Measure current for device list, 
choose Resistor 1 (R1).

5 In the Gain text field, type A_m.

Inductor 2 (L2)
1 In the Model Builder window, click Inductor 2 (L2).

2 In the Settings window for Inductor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the L text field, type L2_m.

Resistor 2 (R2)
1 In the Model Builder window, click Resistor 2 (R2).
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2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type R2_m.

Capacitor 1 (C1)
1 In the Model Builder window, click Capacitor 1 (C1).

2 In the Settings window for Capacitor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the C text field, type C1_m.

External I vs. U 1 (IvsU1)
1 In the Model Builder window, click External I vs. U 1 (IvsU1).

2 In the Settings window for External I vs. U, locate the External Device section.

3 From the V list, choose Voltage from lumped speaker boundary (acpr/lsb1).

4 Locate the Node Connections section. In the table, enter the following settings:

Voltage-Controlled Voltage Source 1 (E1)
1 In the Model Builder window, click Voltage-Controlled Voltage Source 1 (E1).

2 In the Settings window for Voltage-Controlled Voltage Source, locate the 
Node Connections section.
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3 In the table, enter the following settings:

4 Locate the Voltage Measurement section. In the table, enter the following settings:

5 In the Gain text field, type Sd_m[1/m^2].

Current-Controlled Current Source 1 (F1)
1 In the Model Builder window, click Current-Controlled Current Source 1 (F1).

2 In the Settings window for Current-Controlled Current Source, locate the 
Node Connections section.

3 In the table, enter the following settings:

4 Locate the Current Measurement section. From the Measure current for device list, 
choose Voltage-Controlled Voltage Source 1 (E1).

5 In the Gain text field, type Sd_m[1/m^2].

Resistor 3 - Lumped Radiation Impedance
1 In the Model Builder window, under Component 1 (comp1) > Electrical Circuit -

Midwoofer (cir) click Resistor 3 (R3).

2 In the Settings window for Resistor, type Resistor 3 - Lumped Radiation 
Impedance in the Label text field.

3 Locate the Node Connections section. In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type Zrad_m*1[ohm*m^4*s/
kg].
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5 Locate the Node Connections section. In the table, enter the following settings:

Resistor 4 - Lumped Back Volume Compliance
1 In the Model Builder window, under Component 1 (comp1) > Electrical Circuit -

Midwoofer (cir) click Resistor 4 (R4).

2 In the Settings window for Resistor, type Resistor 4 - Lumped Back Volume 
Compliance in the Label text field.

3 Locate the Node Connections section. In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type Zbv_m*1[ohm*m^4*s/
kg].

E L E C T R I C A L  C I R C U I T  2  -  T W E E T E R

1 In the Model Builder window, under Component 1 (comp1) click Electrical Circuit 2 (cir2).

2 In the Settings window for Electrical Circuit, type Electrical Circuit 2 - Tweeter 
in the Label text field.

E L E C T R I C A L  C I R C U I T  -  M I D W O O F E R  ( C I R )

Capacitor 1 (C1), Current-Controlled Current Source 1 (F1), Current-Controlled Voltage 
Source 1 (H1), Current-Controlled Voltage Source 2 (H2), External I vs. U 1 (IvsU1), 
Inductor 1 (L1), Inductor 2 (L2), Resistor 1 (R1), Resistor 2 (R2), Resistor 3 - Lumped 
Radiation Impedance (R3), Resistor 4 - Lumped Back Volume Compliance (R4), Voltage 
Source 1 (V1), Voltage-Controlled Voltage Source 1 (E1)
1 In the Model Builder window, under Component 1 (comp1) > Electrical Circuit - Midwoofer 

(cir), Ctrl-click to select Voltage Source 1 (V1), Resistor 1 (R1), Inductor 1 (L1), Current-

Controlled Voltage Source 1 (H1), Current-Controlled Voltage Source 2 (H2), 
Inductor 2 (L2), Resistor 2 (R2), Capacitor 1 (C1), External I vs. U 1 (IvsU1), Voltage-

Controlled Voltage Source 1 (E1), Current-Controlled Current Source 1 (F1), Resistor 3 -

Lumped Radiation Impedance (R3), and Resistor 4 -

Lumped Back Volume Compliance (R4).
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2 Right-click and choose Copy.

E L E C T R I C A L  C I R C U I T  2  -  T W E E T E R  ( C I R 2 )

In the Model Builder window, under Component 1 (comp1) right-click Electrical Circuit 2 -

Tweeter (cir2) and choose Paste Multiple Items.

Voltage Source 1 (V1)
1 In the Settings window for Voltage Source, locate the Node Connections section.

2 In the table, enter the following settings:

Resistor 1 (R1)
1 In the Model Builder window, click Resistor 1 (R1).

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type R1_t.

Inductor 1 (L1)
1 In the Model Builder window, click Inductor 1 (L1).

2 In the Settings window for Inductor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the L text field, type L1_t.

Current-Controlled Voltage Source 1 (H1)
1 In the Model Builder window, click Current-Controlled Voltage Source 1 (H1).

2 In the Settings window for Current-Controlled Voltage Source, locate the 
Node Connections section.
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3 In the table, enter the following settings:

4 Locate the Current Measurement section. From the Measure current for device list, 
choose Inductor 2 (L2).

5 In the Gain text field, type A_t.

Current-Controlled Voltage Source 2 (H2)
1 In the Model Builder window, click Current-Controlled Voltage Source 2 (H2).

2 In the Settings window for Current-Controlled Voltage Source, locate the 
Node Connections section.

3 In the table, enter the following settings:

4 Locate the Current Measurement section. In the Gain text field, type A_t.

Inductor 2 (L2)
1 In the Model Builder window, click Inductor 2 (L2).

2 In the Settings window for Inductor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the L text field, type L2_t.

Resistor 2 (R2)
1 In the Model Builder window, click Resistor 2 (R2).

2 In the Settings window for Resistor, locate the Node Connections section.
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3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type R2_t.

Capacitor 1 (C1)
1 In the Model Builder window, click Capacitor 1 (C1).

2 In the Settings window for Capacitor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the C text field, type C1_t.

External I vs. U 1 (IvsU1)
1 In the Model Builder window, click External I vs. U 1 (IvsU1).

2 In the Settings window for External I vs. U, locate the External Device section.

3 From the V list, choose Voltage from lumped speaker boundary (acpr/lsb2).

4 Locate the Node Connections section. In the table, enter the following settings:

Voltage-Controlled Voltage Source 1 (E1)
1 In the Model Builder window, click Voltage-Controlled Voltage Source 1 (E1).

2 In the Settings window for Voltage-Controlled Voltage Source, locate the 
Node Connections section.

3 In the table, enter the following settings:
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4 Locate the Voltage Measurement section. In the table, enter the following settings:

5 In the Gain text field, type Sd_t[1/m^2].

Current-Controlled Current Source 1 (F1)
1 In the Model Builder window, click Current-Controlled Current Source 1 (F1).

2 In the Settings window for Current-Controlled Current Source, locate the 
Node Connections section.

3 In the table, enter the following settings:

4 Locate the Current Measurement section. In the Gain text field, type Sd_t[1/m^2].

Resistor 3 - Lumped Radiation Impedance (R3)
1 In the Model Builder window, click Resistor 3 - Lumped Radiation Impedance (R3).

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:

4 Locate the Device Parameters section. In the R text field, type Zrad_t*1[ohm*m^4*s/
kg].

Resistor 4 - Lumped Back Volume Compliance (R4)
1 In the Model Builder window, click Resistor 4 - Lumped Back Volume Compliance (R4).

2 In the Settings window for Resistor, locate the Node Connections section.

3 In the table, enter the following settings:
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4 Locate the Device Parameters section. In the R text field, type Zbv_t*1[ohm*m^4*s/
kg].

Next, create a mesh to study the electrical circuits. Although it is not used by the solver, 
the acoustic domain still needs to be meshed. The element size therefore does not need to 
be fine.

M E S H  1  -  E L E C T R I C A L  C I R C U I T S

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, type Mesh 1 - Electrical Circuits in the Label 
text field.

3 Locate the Physics-Controlled Mesh section. In the table, clear the Use checkboxes for 
Geometric Analysis, Detail Size and Pressure Acoustics, Frequency Domain (acpr).

4 Click Build All.

Proceed with the study to investigate the responses of the midwoofer and tweeter. 
Remember to disable the coupling with the acoustic domain in this case.

S T U D Y  1  -  S P E A K E R  R E S P O N S E S

1 In the Settings window for Study, type Study 1 - Speaker Responses in the Label 
text field.

2 Locate the Study Settings section. Clear the Generate default plots checkbox.

Step 1: Frequency Domain
1 In the Model Builder window, under Study 1 - Speaker Responses click 

Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 Click Range.

4 In the Range dialog, choose ISO preferred frequencies from the Entry method list.

5 In the Start frequency text field, type 50.

6 In the Stop frequency text field, type 10000.

7 From the Interval list, choose 1/6 octave.

8 Click Replace.

9 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

10 Select the Modify model configuration for study step checkbox.

11 In the tree, select Component 1 (comp1) > Pressure Acoustics, Frequency Domain (acpr).
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12 Click Disable in Solvers.

13 In the tree, select Component 1 (comp1) > Electrical Circuit - Midwoofer (cir) > 
External I vs. U 1 (IvsU1).

14 Click Disable.

15 In the tree, select Component 1 (comp1) > Electrical Circuit 2 - Tweeter (cir2) > 
External I vs. U 1 (IvsU1).

16 Click Disable.

17 In the Study toolbar, click Compute.

R E S U L T S

1 In the Model Builder window, click Results.

2 In the Settings window for Results, locate the Update of Results section.

3 Select the Only plot when requested checkbox.

Speaker Responses
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Speaker Responses in the Label text 
field.

3 Click to expand the Title section. From the Title type list, choose Label.

4 Locate the Legend section. From the Position list, choose Lower right.

Octave Band 1
1 In the Speaker Responses toolbar, click More Plots and choose Octave Band.

2 In the Settings window for Octave Band, locate the Selection section.

3 From the Geometric entity level list, choose Global.

4 Locate the y-Axis Data section. In the Expression text field, type acpr.iomega*rho0*
cir.R3.i*exp(-i*k0*1[m])/(2*pi*1[m]).

5 Locate the Plot section. From the Quantity list, choose 
Continuous power spectral density.

6 Click to expand the Legends section. Select the Show legends checkbox.

7 From the Legends list, choose Manual.

8 In the table, enter the following settings:

Legends

Midwoofer
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Octave Band 2
1 Right-click Octave Band 1 and choose Duplicate.

2 In the Settings window for Octave Band, locate the y-Axis Data section.

3 In the Expression text field, type acpr.iomega*rho0*cir2.R3.i*exp(-i*k0*1[m])/
(2*pi*1[m]).

4 Locate the Legends section. In the table, enter the following settings:

5 In the Speaker Responses toolbar, click Plot.

Now set up the studies and their corresponding meshes to investigate the acoustics of the 
car cabin.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select More Studies > Eigenfrequency.

4 Click the Add Study button in the window toolbar.

Legends

Tweeter
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5 In the Select Study tree, select General Studies > Frequency Domain.

6 Click the Add Study button in the window toolbar three times.

7 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  4

Step 1: Frequency Domain
The second mesh will be used for eigenfrequency search and frequency sweeps. It is built 
as a fixed mesh based on the highest frequency of the sweep. In general, five to six second-
order elements per wavelength are needed to resolve the waves. For more details, see 
Meshing (Resolving the Waves) in the Acoustics Module User’s Guide. In this model, use 
five elements per wavelength. The mesh is also set to avoid generating small elements due 
to the many small surfaces and edges in the geometry.

M E S H  1  -  E L E C T R I C A L  C I R C U I T S

In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 -

Electrical Circuits and choose Duplicate.

M E S H  2  -  F I X E D  M E S H  F O R  F R E Q U E N C Y  S W E E P S

1 In the Settings window for Mesh, locate the Physics-Controlled Mesh section.

2 In the table, select the Use checkbox for Pressure Acoustics, Frequency Domain (acpr).

3 In the Model Builder window, click Mesh 1 - Electrical Circuits 1.

4 In the Label text field, type Mesh 2 - Fixed Mesh for Frequency Sweeps.

5 Locate the Pressure Acoustics, Frequency Domain (acpr) section. From the 
Maximum mesh element size control parameter list, choose Frequency.

6 Locate the Sequence Type section. From the list, choose User-controlled mesh.

Size
1 In the Model Builder window, under Component 1 (comp1) > Meshes > Mesh 2 -

Fixed Mesh for Frequency Sweeps click Size.

2 In the Settings window for Size, locate the Element Size Parameters section.

3 In the Maximum element size text field, type c0/fmax/5.

4 In the Minimum element size text field, type 0.06.

Size Expression 1
In the Model Builder window, right-click Size Expression 1 and choose Delete.
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Free Tetrahedral 1
1 In the Settings window for Free Tetrahedral, click to expand the 

Element Quality Optimization section.

2 Select the Avoid elements that are too small checkbox.

3 Click Build All.

4 In the Model Builder window, right-click Mesh 2 - Fixed Mesh for Frequency Sweeps and 
choose Duplicate.

M E S H  3  -  A D A P T I V E  M E S H  F O R  H I G H  F R E Q U E N C I E S

The third mesh will be used to study individual high frequencies. It is set up as an adaptive 
mesh which will be rebuilt for every frequency value of the parametric sweep.

1 In the Settings window for Mesh, type Mesh 3 - Adaptive Mesh for High 
Frequencies in the Label text field.

Size
1 In the Model Builder window, expand the Mesh 3 - Adaptive Mesh for High Frequencies 

node, then click Size.

2 In the Settings window for Size, locate the Element Size Parameters section.

3 In the Maximum element size text field, type c0/f0/5.
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Set up and perform the eigenfrequency study. This only depends on the geometry and 
boundary conditions of the acoustic domain, the electrical circuits should therefore be 
disabled.

S T U D Y  2  -  M O D A L  A N A L Y S I S

1 In the Model Builder window, click Study 2.

2 In the Settings window for Study, type Study 2 - Modal Analysis in the Label text 
field.

Step 1: Eigenfrequency
1 In the Model Builder window, under Study 2 - Modal Analysis click Step 1: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 From the Search method around shift list, choose Larger real part.

4 Locate the Physics and Variables Selection section. In the Solve for column of the table, 
under Component 1 (comp1), clear the checkboxes for Electrical Circuit - Midwoofer (cir) 
and Electrical Circuit 2 - Tweeter (cir2).

5 Click to expand the Mesh Selection section. In the table, enter the following settings:

6 In the Study toolbar, click Compute.

R E S U L T S

Acoustic Pressure (acpr)
1 In the Settings window for 3D Plot Group, locate the Data section.

2 From the Eigenfrequency (Hz) list, choose 111.14+5.4815i.

3 Click to expand the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Pressure Eigenmodes.

5 In the Parameter indicator text field, type Eigenfrequency=eval(freq) Hz.

6 In the Acoustic Pressure (acpr) toolbar, click Plot.

7 Locate the Data section. From the Eigenfrequency (Hz) list, choose 129.72+1.573i.

8 In the Acoustic Pressure (acpr) toolbar, click Plot.

Loop through the eigenfrequencies to analyze the different modes of the car cabin.

Component Mesh

Component 1 Mesh 2 - Fixed Mesh for Frequency Sweeps
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Sound Pressure Level (acpr)
1 In the Model Builder window, click Sound Pressure Level (acpr).

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Eigenfrequency (Hz) list, choose 111.14+5.4815i.

4 Locate the Title section. From the Title type list, choose Manual.

5 In the Title text area, type SPL Eigenmodes.

6 In the Parameter indicator text field, type Eigenfrequency=eval(freq) Hz.

7 In the Sound Pressure Level (acpr) toolbar, click Plot.

8 Locate the Data section. From the Eigenfrequency (Hz) list, choose 129.72+1.573i.

9 In the Sound Pressure Level (acpr) toolbar, click Plot.

Proceed with the studies investigating the car cabin response to loudspeaker excitation. 
Reduce the data to be stored by limiting it to relevant selections only. In the solver settings, 
also select the Block low rank factorization option to speed up the calculations.

S T U D Y  3  -  F R E Q U E N C Y  S W E E P  U P  T O  F M A X

1 In the Model Builder window, click Study 3.

2 In the Settings window for Study, type Study 3 - Frequency Sweep up to fmax in 
the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots checkbox.

Step 1: Frequency Domain
1 In the Model Builder window, under Study 3 - Frequency Sweep up to fmax click 

Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 Click Range.

4 In the Range dialog, choose ISO preferred frequencies from the Entry method list.

5 In the Start frequency text field, type 50.

6 In the Stop frequency text field, type fmax.

7 From the Interval list, choose 1/12 octave.

8 Click Replace.

9 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

10 Select the Modify model configuration for study step checkbox.
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11 In the tree, select Component 1 (comp1) > Electrical Circuit - Midwoofer (cir) > Voltage-

Controlled Voltage Source 1 (E1), Component 1 (comp1) > Electrical Circuit -

Midwoofer (cir) > Current-Controlled Current Source 1 (F1), Component 1 (comp1) > 
Electrical Circuit - Midwoofer (cir) > Resistor 3 - Lumped Radiation Impedance (R3), and 
Component 1 (comp1) > Electrical Circuit - Midwoofer (cir) > Resistor 4 -

Lumped Back Volume Compliance (R4).

12 Click Disable.

13 In the tree, select Component 1 (comp1) > Electrical Circuit 2 - Tweeter (cir2) > Voltage-

Controlled Voltage Source 1 (E1), Component 1 (comp1) > Electrical Circuit 2 -

Tweeter (cir2) > Current-Controlled Current Source 1 (F1), Component 1 (comp1) > 
Electrical Circuit 2 - Tweeter (cir2) > Resistor 3 - Lumped Radiation Impedance (R3), and 
Component 1 (comp1) > Electrical Circuit 2 - Tweeter (cir2) > Resistor 4 -

Lumped Back Volume Compliance (R4).

14 Click Disable.

15 Click to expand the Store in Output section. In the table, enter the following settings:

16 Under Selections, click Add.

17 In the Add dialog, select Microphone Array in the Selections list.

18 Click OK.

19 In the Settings window for Frequency Domain, click to expand the Mesh Selection section.

20 In the table, enter the following settings:

Solution 3 (sol3)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 3 (sol3) node.

3 In the Model Builder window, expand the Study 3 - Frequency Sweep up to fmax > 
Solver Configurations > Solution 3 (sol3) > Stationary Solver 1 node, then click 
Suggested Direct Solver (cir2_acpr_...).

4 In the Settings window for Direct, locate the General section.

5 Select the Block low rank factorization checkbox.

Interface Output Selection

Pressure Acoustics, Frequency Domain (acpr) Selection

Component Mesh

Component 1 Mesh 2 - Fixed Mesh for Frequency Sweeps
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S T U D Y  4  -  F R E Q U E N C Y  S W E E P  U P  T O  F M A X  ( M I D W O O F E R  O N L Y )

1 In the Model Builder window, click Study 4.

2 In the Settings window for Study, type Study 4 - Frequency Sweep up to fmax 
(Midwoofer Only) in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots checkbox.

Step 1: Frequency Domain
1 In the Model Builder window, under Study 4 -

Frequency Sweep up to fmax (Midwoofer Only) click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

3 Click Range.

4 In the Range dialog, choose ISO preferred frequencies from the Entry method list.

5 In the Start frequency text field, type 50.

6 In the Stop frequency text field, type fmax.

7 From the Interval list, choose 1/12 octave.

8 Click Replace.

9 In the Settings window for Frequency Domain, locate the Physics and Variables Selection 
section.

10 Select the Modify model configuration for study step checkbox.

11 In the tree, select Component 1 (comp1) > Pressure Acoustics, Frequency Domain (acpr) > 
Lumped Speaker Boundary 2 - Tweeter R.

12 Click Disable.

13 In the tree, select Component 1 (comp1) > Electrical Circuit - Midwoofer (cir) > Voltage-

Controlled Voltage Source 1 (E1), Component 1 (comp1) > Electrical Circuit -

Midwoofer (cir) > Current-Controlled Current Source 1 (F1), Component 1 (comp1) > 
Electrical Circuit - Midwoofer (cir) > Resistor 3 - Lumped Radiation Impedance (R3), and 
Component 1 (comp1) > Electrical Circuit - Midwoofer (cir) > Resistor 4 -

Lumped Back Volume Compliance (R4).

14 Click Disable.

15 In the tree, select Component 1 (comp1) > Electrical Circuit 2 - Tweeter (cir2).

16 Click Disable in Model.

17 Locate the Store in Output section. In the table, enter the following settings:

Interface Output Selection

Pressure Acoustics, Frequency Domain (acpr) Selection
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18 Under Selections, click Add.

19 In the Add dialog, select Microphone Array in the Selections list.

20 Click OK.

21 In the Settings window for Frequency Domain, locate the Mesh Selection section.

22 In the table, enter the following settings:

Solution 4 (sol4)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 4 (sol4) node.

3 In the Model Builder window, expand the Study 4 -

Frequency Sweep up to fmax (Midwoofer Only) > Solver Configurations > Solution 4 (sol4) 
> Stationary Solver 1 node, then click Suggested Direct Solver (acpr_cir).

4 In the Settings window for Direct, locate the General section.

5 Select the Block low rank factorization checkbox.

S T U D Y  5  -  S I N G L E  F R E Q U E N C I E S  A B O V E  F M A X

1 In the Model Builder window, click Study 5.

2 In the Settings window for Study, type Study 5 - Single Frequencies Above fmax 
in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots checkbox.

Parametric Sweep
1 In the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add.

4 In the table, enter the following settings:

Step 1: Frequency Domain
1 In the Model Builder window, click Step 1: Frequency Domain.

2 In the Settings window for Frequency Domain, locate the Study Settings section.

Component Mesh

Component 1 Mesh 2 - Fixed Mesh for Frequency Sweeps

Parameter name Parameter value list Parameter unit

f0 (Study frequency) 2000, 3000, 4000 Hz
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3 In the Frequencies text field, type f0.

4 Locate the Physics and Variables Selection section. Select the 
Modify model configuration for study step checkbox.

5 In the tree, select Component 1 (comp1) > Electrical Circuit - Midwoofer (cir) > Voltage-

Controlled Voltage Source 1 (E1), Component 1 (comp1) > Electrical Circuit -

Midwoofer (cir) > Current-Controlled Current Source 1 (F1), Component 1 (comp1) > 
Electrical Circuit - Midwoofer (cir) > Resistor 3 - Lumped Radiation Impedance (R3), and 
Component 1 (comp1) > Electrical Circuit - Midwoofer (cir) > Resistor 4 -

Lumped Back Volume Compliance (R4).

6 Click Disable.

7 In the tree, select Component 1 (comp1) > Electrical Circuit 2 - Tweeter (cir2) > Voltage-

Controlled Voltage Source 1 (E1), Component 1 (comp1) > Electrical Circuit 2 -

Tweeter (cir2) > Current-Controlled Current Source 1 (F1), Component 1 (comp1) > 
Electrical Circuit 2 - Tweeter (cir2) > Resistor 3 - Lumped Radiation Impedance (R3), and 
Component 1 (comp1) > Electrical Circuit 2 - Tweeter (cir2) > Resistor 4 -

Lumped Back Volume Compliance (R4).

8 Click Disable.

9 Locate the Store in Output section. In the table, enter the following settings:

10 Under Selections, click Add.

11 In the Add dialog, in the Selections list, choose All Boundaries and Microphone Array.

12 Click OK.

13 In the Settings window for Frequency Domain, locate the Mesh Selection section.

14 In the table, enter the following settings:

Select the iterative solver with Shifted Laplace among the list of suggested solvers to 
reduce computation time at high frequencies.

Solution 5 (sol5)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 5 (sol5) node.

Interface Output Selection

Pressure Acoustics, Frequency Domain (acpr) Selection

Component Mesh

Component 1 Mesh 3 - Adaptive Mesh for High Frequencies
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3 In the Model Builder window, expand the Study 5 - Single Frequencies Above fmax > 
Solver Configurations > Solution 5 (sol5) > Stationary Solver 1 node.

4 Right-click Study 5 - Single Frequencies Above fmax > Solver Configurations > 
Solution 5 (sol5) > Stationary Solver 1 > 
Suggested Iterative Solver (Shifted Laplace) (cir2_acpr_...) and choose Enable.

5 In the Model Builder window, expand the Study 5 - Single Frequencies Above fmax > 
Solver Configurations > Solution 5 (sol5) > Stationary Solver 1 > 
Suggested Iterative Solver (Shifted Laplace) (cir2_acpr_...) > Multigrid 1 > Coarse Solver 
node, then click Direct.

6 In the Settings window for Direct, locate the General section.

7 Select the Block low rank factorization checkbox.

Create an overall study to automatically run all the frequency studies one after the other.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select Empty Study.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  6  -  A L L  F R E Q U E N C Y  A N A L Y S E S

1 In the Settings window for Study, type Study 6 - All Frequency Analyses in the 
Label text field.

2 Locate the Study Settings section. Clear the Generate default plots checkbox.

Study 3
1 In the Study toolbar, click More Study Extensions and choose Study Reference.

2 In the Settings window for Study Reference, type Study 3 in the Label text field.

3 Locate the Study Reference section. From the Study reference list, choose Study 3 -

Frequency Sweep up to fmax.

Study 4
1 In the Study toolbar, click More Study Extensions and choose Study Reference.

2 In the Settings window for Study Reference, type Study 4 in the Label text field.

3 Locate the Study Reference section. From the Study reference list, choose Study 4 -

Frequency Sweep up to fmax (Midwoofer Only).
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Study 5
1 In the Study toolbar, click More Study Extensions and choose Study Reference.

2 In the Settings window for Study Reference, type Study 5 in the Label text field.

3 Locate the Study Reference section. From the Study reference list, choose Study 5 -

Single Frequencies Above fmax.

4 In the Study toolbar, click Compute.

Proceed with the results, starting with the frequency response at the microphone positions 
and then looking at the SPL on the model’s boundary surfaces.

R E S U L T S

Cabin response
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Cabin response in the Label text field.

3 Locate the Data section. From the Dataset list, choose None.

4 Locate the Title section. From the Title type list, choose Label.

5 Locate the Legend section. From the Position list, choose Lower right.

Octave Band 1
1 In the Cabin response toolbar, click More Plots and choose Octave Band.

2 In the Settings window for Octave Band, locate the Data section.

3 From the Dataset list, choose Study 3 - Frequency Sweep up to fmax/Solution 3 (sol3).

4 Locate the Selection section. From the Geometric entity level list, choose Point.

5 Select Points 543–545 only.

6 Locate the Plot section. From the Quantity list, choose 
Continuous power spectral density.

7 Click to expand the Coloring and Style section. Find the Line markers subsection. From 
the Marker list, choose Point.

8 Locate the Legends section. Select the Show legends checkbox.

9 From the Legends list, choose Manual.

10 In the table, enter the following settings:

Legends

Study 3
45 |  C A R  C A B I N  A C O U S T I C S  —   F R E Q U E N C Y - D O M A I N  A N A L Y S I S



Octave Band 2
1 Right-click Octave Band 1 and choose Duplicate.

2 In the Settings window for Octave Band, locate the Data section.

3 From the Dataset list, choose Study 5 - Single Frequencies Above fmax/

Parametric Solutions 1 (sol7).

4 Locate the Coloring and Style section. Find the Line style subsection. From the Line list, 
choose Dashed.

5 From the Color list, choose Cycle (reset).

6 Find the Line markers subsection. From the Marker list, choose Asterisk.

7 Locate the Legends section. In the table, enter the following settings:

8 In the Cabin response toolbar, click Plot.

Cabin Response - Speaker Comparison
1 In the Model Builder window, right-click Cabin response and choose Duplicate.

2 In the Model Builder window, click Cabin response 1.

Legends

Study 5
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3 In the Settings window for 1D Plot Group, type Cabin Response - Speaker 
Comparison in the Label text field.

Octave Band 1
1 In the Model Builder window, click Octave Band 1.

2 In the Settings window for Octave Band, locate the Legends section.

3 In the table, enter the following settings:

Octave Band 2
1 In the Model Builder window, click Octave Band 2.

2 In the Settings window for Octave Band, locate the Data section.

3 From the Dataset list, choose Study 4 - Frequency Sweep up to fmax (Midwoofer Only)/

Solution 4 (sol4).

4 Locate the Coloring and Style section. From the Color list, choose Cycle.

5 Locate the Legends section. In the table, enter the following settings:

Legends

Midwoofer and tweeter

Legends

Midwoofer only
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6 In the Cabin Response - Speaker Comparison toolbar, click Plot.

R E S U L T  T E M P L A T E S

1 In the Results toolbar, click Result Templates to open the Result Templates window.

2 Go to the Result Templates window.

3 In the tree, select Study 5 - Single Frequencies Above fmax/Parametric Solutions 1 (sol7) > 
Pressure Acoustics, Frequency Domain > Sound Pressure Level (acpr).

4 Click the Add Result Template button in the window toolbar.

5 In the Results toolbar, click Result Templates to close the Result Templates window.

R E S U L T S

Surface SPL
To visualize the SPL inside the car, start by selecting all boundaries and then manually 
remove some roof and window surfaces from the selection.

1 In the Settings window for 3D Plot Group, type Surface SPL in the Label text field.

2 Click to expand the Selection section. From the Geometric entity level list, choose 
Boundary.

3 Click Paste Selection.
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4 In the Paste Selection dialog, type 1, 2, 4-61, 63-256, 258-476, 478-488, 490-
711, 713-808 in the Selection text field.

5 Click OK.

6 In the Settings window for 3D Plot Group, locate the Title section.

7 From the Title type list, choose Label.

8 In the Surface SPL toolbar, click Plot.

Absorption Coefficients
1 Right-click Surface SPL and choose Duplicate.

The absorption coefficient of the boundaries can also be plotted. Choose to display the 
selection for the seat boundaries and add a few other relevant surfaces.

2 In the Settings window for 3D Plot Group, type Absorption Coefficients in the Label 
text field.

3 Locate the Data section. From the Parameter value (f0 (Hz)) list, choose 2000.

4 Locate the Selection section. Click to select the Activate Selection toggle button.

5 Click Clear Selection.

6 Click Paste Selection.
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7 In the Paste Selection dialog, type 4, 7, 10, 64, 198, 199, 202, 203, 210, 211, 
228, 229, 231-233, 236, 237, 240, 241, 244-247, 258, 269, 275-278, 293, 

294, 297-300, 326-335, 340-349, 354, 355, 367, 368, 375, 381-392, 397-

414, 417-424, 427-433, 449-455, 465-476, 478, 561, 562, 564, 565, 568-

579, 594, 595, 601-607, 641-647, 654, 663, 664, 671, 672, 687, 698-

711, 713, 716-738, 747-754, 756-766, 771, 777-796, 798, 799, 804, 805 
in the Selection text field.

8 Click OK.

Surface 1
1 In the Model Builder window, expand the Absorption Coefficients node, then click 

Surface 1.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type alpha_all.

4 From the Unit list, choose 1.

5 Click to expand the Range section. Select the Manual color range checkbox.

6 In the Minimum text field, type 0.

7 In the Maximum text field, type 1.

8 In the Absorption Coefficients toolbar, click Plot.
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